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de animacgdes e videos

Este tutorial foi produzido como recurso para auxiliar professores e alunos na construgéo de animagdes e videos. Foi elaborado no ambito do Curso
de Mestrado Profissional e faz parte integrante do produto produzido durante a pesquisa. O campo de estudo desta pesquisa esta inserido na area de
concentragéo do programa de P6s-graduagéo em Ensino de Educacho Bésica, PPGEB, do CAp — UERJ, voltada ao “Cotidiano e Curriculo do Ensino
Fundamental” e tem como foco o primeiro segmento do Ensino Fundamental.
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TUTORIAL DO SOFTWARE MUAN




O que é 0 MUAN?

MUAN (Manipulador Universal de Animacdo) é uma ferramenta de apoio a construcdo de
animacao do tipo quadro-a-quadro, compativel com os sistemas operacionais Linux, Windows

e Macintosh.
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O MUAN foi concebido pelo Anima Mundi (Festival Internacional de Animacao do Brasil) e
desenvolvido pelo IMPA, Instituto de Matematica Pura e Aplicada em parceria com a IBM,

Instituto Brasileiro de Matematica.

O Software MUAN possui uma interface simples que permite a criacdo e edigdo “basica” de

animac0es por iniciantes e profissionais.

O MUAN ¢ um software livre. Para baixa-lo é simples! Acesse:



www.muan.org.br/muan/dowload

Clique e faga 0 “Download” do software MUAN. E rapido e facil!

[ MUAN x = - 1%

= C' | [3 www.muan.org.br/br/muan/download % O =
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XQ«' ANIMA MUNDI Crie um perfil | Login & | Contato | Buscar na galeria BN vovadosiea | Portugues &
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Manipurapor Universat oe ANIMACOES

Baixe as novas versoes do MUAN!

Contamos com o Seu retorno para o aperfeicoamento do software. Envie seus comentarios
para muan@animamundi.com.br ou use o botdo "Reportar Erro" na interface do MUAN para
informar aos desenvolvedores sobre qualquer problema encontrado.

Windows / versao 12.0.5 / portugués / 7Mb

Windows

Mac / versdo 12.0.5 / portugués / 7Mb

Através de webcam, camera digital ou da propria cAmera embutida no laptop, vocé captura as

imagens com o auxilio do software MUAN.

Essas imagens sdo mostradas no painel de imagens. Lembre-se: para cada segundo de animacgéo

€ necessario capturar 30 imagens! Mas veremos isso mais adiante.

Com essa sequéncia de imagens vocé podera reproduzir sua animacao que devera ser salva no
formato AVI (Audio Video Interleave).

Esse é a tela inicial do MUAN.
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http://www.muan.org.br/muan/dowload

Como usar o MUAN?
Para iniciar um novo projeto:

1.0 primeiro passo € escolher a resolugdo que vocé vai usar, normalmente a resolucdo de sua

camera ou webcam. Essa tela aparece automaticamente assim que vocé abre o MUAN.

Propriedades de Property Sheet 4

Formato de fluo l

Formato de video Compactacdo

Padrio de video: | Mone
Intervalo de
Taxa de quadros: | 10.000 j quadros I: j
- Intervalo de =
=1

Espacgo de cores [ compactacdo: quadros P:

|vuy2 -]
Tamanho da saida: Qualidade:

| 1280 x 720 - 3
5640 x 480 (default)
160 x 120
176 » 144 | Cancelar | Aplicar |
320 x 2490

352 x 288

2.Clique no botao “Novo” para iniciar uma nova animagao.
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3. Caso ja tenha comegado a capturar as imagens, clique em “Carregar” para carregar uma
animacao ou uma cena que ja esteja salva e continuar de onde vocé parou. VVamos ver como

capturar mais a frente.
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4. Para inserir uma imagem ou video ja salvo, clique em inserir e em OK para confirmar

imagem ou video sera inserido a partir do frame onde vocé parou.
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5. Se vocé ja tiver escolhido o local onde sua animac&o sera salva e nomeado o arquivo, basta

clicar em “Salvar”. O MUAN salva automaticamente, mas ¢ bom vocé ir salvando as cenas,

principalmente se sua animacéo for grande, para ndo correr riscos.

- x
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Para “Salvar Como”, escolha a resolu¢do (0 MUAN da as opcdes).

Escolha o diretdrio em que quer salvar, nomeie o arquivo. Pode abrir uma pasta ou colocar em

“Favoritos”.
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7. Para “Exportar”, escolha a extensdo do seu arquivo, que pode ser avi, jpg, mpg.

Escolha o local onde quer salvar, nomeie o arquivo e clique em OK para confirmar.
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Entéo, selecione a pasta em que elas se encontram e aperte OK.

Exportar animagao ...

Show: |* {avi,jpg mpg} v| Favorites | &

7] |
bin/

manual/

plugins/

galinha.avi

[V Preview
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8. Vocé pode importar de seu computador as imagens que serdo usadas para fazer a animacao.

Essas imagens devem estar no formato jpeg e precisam estar nomeadas de forma sequenciada

para serem reconhecidas pelo programa.
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Vocé pode optar por capturar as imagens com uma webcam, filmadora ou cadmera digital. O

painel de imagem exibe as imagens capturadas em tempo real. Caso vocé esteja utilizando uma

filmadora ou camera digital estas deverdo estar conectadas em uma placa de captura.

MUAN*v12.0.5
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Se for utilizar a webcam, certifique-se de que a camera do seu notebook esteja desativada.

Acesse 0 Gerenciador de Dispositivos no seu computador, procure na lista a camera do

notebook, cliqgue com o botdo direito do mouse e desative para ndo dar conflito.

@ Gerenciador de Dispositivos
Exibir  Ajuda

E oo

Arquivo  Agso

9= =h | o

2F | 5 R S

< = Vera
&8 Adsptadores de rede
W= Adsptadores de video
3P Batenas
© Bluetcoth
58 Computador

< c se

Cu Controladores IDE ATA/ATAPY

% Controladores de som, video « jogos

serial sal)

@ C USE (b

=55 USB 2.0 UVC HD Webc~—
055 Duspositivos de interface -
@@ Dispositivos de sistema
L. .2 Dispositivos de tecnologia
L Dispositivos do software
& Entrades e saidas de sudio

~ T Dispositivos de geragio de imagens
45 Microsoft LifeCam HD-3000

Atualizar Driver...
Desativar

Desinstalar

Verificar se ha alteragSes de hardware

Propricdades

- Unidades de disco
=& Unidades de DVD/CD-ROM

Desabilitar o dispositivo selecionado.

1. Para tirar uma foto clique no botdo CAPTURAR. Quando vocé comeca a capturar as

imagens, observe que aparece no canto superior esquerdo do painel a palavra



“CAMERA”. Lembre-se que 0s movimentos precisam ser lentos para dar o efeito

animado desejado.
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As imagens capturadas devem aparecer na tela. Caso ndo estejam aparecendo ainda, clique no
botdo “Memdria-Camera”.

Cada imagem capturada é um frame da animacdo.

A quantidade de frames e a duracdo podem ser vistos no canto inferior direito.
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2. Para cada segundo de animacdo sdo necessarios trinta frames. Para facilitar, vocé pode
mudar a duracdo para 3 e capturar apenas 10 imagens diferentes. Dessa forma vocé tera

um segundo de animagdo e o efeito sera praticamente 0 mesmo.

3. Paravisualizar a animagéo aperte o botdo “play”. Para parar o botdo “stop” e para mover

de um frame para outro use as setas.
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4. E possivel alterar o tempo de duragfo de cada frame. Para isso, escreva o niimero do
frame que vocé deseja alterar em “Ir para”, clique em DURACAO e escreva o tempo

que vocé quer que o frame apareca e aperte a tecla “enter” de seu teclado.
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As vezes é necessario alterar a duragdo para que os movimentos da animagao transcorram de
forma mais delicada e natural.
5. Para visualizar um trecho da animagéo, clique em “inicio”, escreva o numero do frame,

depois clique em “fim” e digite 0 nimero do ultimo frame a ser visualizado. Apo6s

marcar o inicio e o fim, selecione a opgao “trecho”. Agora sim, aperte o play e visualize

sua animagéo.

Parceria Tecnciogica IBM
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6. Ao selecionar a opgdo “loop” e clicar em “play” sua animagdo vai repetindo, sempre

que chega ao fim ela volta para o inicio. Vocé pode delimitar o loop selecionando o

trecho.
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7. Na opcao “Flipar”, é possivel ver a tltima imagem capturada e a atual alternadamente.

8. Na opg¢ao “Transparéncia” ¢ possivel ver a imagem capturada ¢ a atual da camara
sobrepostas. Tanto a op¢do Flipar quanto a Transparéncia auxiliam quando queremos
ver a posigéo anterior e a atual. E de grande utilidade quando esbarramos ou tiramos o

objeto da posicao original.
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9. Para repetir um ou mais frames, marque o “inicio” e o “fim”, clique em “trecho”.
Depois, clique em “copiar”.
Para incluir o frame na animacédo posicione na parte do filme escolhida e clique na
fungao “colar”.

Vocé pode também “colar invertido”, nesse caso, o primeiro frame do trecho sera o
b 9

altimo
# 7 IMPA-VISGRAF/ Anima Mundi MUAN* v12.0.5 Parceria Tecnolégica IBM -_ X
AN 205
e
sai
—
Sobe
—
Manual
s
Preteranci
Zavves o
E—
Exportar
iro Gamen
importar Imagens
etesiceses il
Meméxia = Cimen
e
Teta Cheis e
..... = K a . m » » o Ouwssto contues N AA
i — [Pama]
Trecho = .77
o Atual
= CAPTURAR
Golar nvertid
Arquivo:



10. Para deletar algum frame, visualize-o no painel de imagem, marque “inicio” e “fim”,

clique no botdo “remover” e depois clique em enter, confirmando a exclusao.
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11. Depois de organizar seus frames, ¢ hora de salvar. Para isso clique em “salvar como” e

em seguida “atual”.
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O MUAN salva automético mas se a animacdo for muito longa é bom ir salvando. Atencao!
Quando 0 nome do arquivo estd em vermelho significa que o arquivo ndo esta com as Ultimas

atualizacOes salvas.

Selecione o local, por exemplo: “C” e ap6s, em “arquivo de programas”.
Escreva 0 nome de seu arquivo em filename seguido de “... .avi”. (C:/muan/galinhas.avi) e

aperte OK.
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Pronto! Agora é so editar sua animacéao!

O MUAN captura as imagens, mas para editar vocé vai precisar de outro programa, pode ser o

Movie Maker ou o Adobe Premiere, por exemplo.



TUTORIAL DO MOVIE MAKER




Tutorial do Movie Maker

O Windows Movie Maker é um software basico para editar videos. Com os recursos oferecidos

é possivel criar videos simples.

Essa é a interface do Movie Maker. Sua interface apresenta uma linha do tempo onde aparece
a sequéncia das imagens selecionadas, op¢do para adicionar audio, transices e opcles para
compartilhamento no Facebook, Youtube e One Drive.

You >
r

il

Para iniciar seu projeto vocé€ comega adicionando videos e fotos. Clique no botao “Adicionar

videos e fotos”.

B = = | Meu Filme - Movie Maker

m Inicio Animacdes Efeitos Visuais Projeto Exibir
Ej.— @ video da Webcam [&s] Titulo
(=

Colar Adicionar j— . = e
wideos e Tatos [E] instantaneo 4Z| créditos -

Adicionar videos e fotos.

Adicione wideos e fotos ao projeto.




Escolha os arquivos (fotos, videos), selecione e clique em abrir.

Bl Adicione Videos e Fotos X
& « Usudrios » Vera » Imagens » v O Pesquisar Imagens 2
Organizar « Nova pasta = + [N 0

s Acesso rapido S vE-L() "

I Area de Trab:
tf] Documentos
‘ Downloads

&=| Imagens

Imagens da Imagens Salvas
Camera

=2 Fi\
J’! Musicas

¢@ OneDrive

image3

[ Este Computador v 5-7(3)
v

image2" w | Videos e Fotos ~

I Abrir Cancelar

Horme: |"image3" "image’

Suas imagens aparecerdo na linha do tempo como mostra a figura abaixo. Caso queira mudar a

duragdo de exibi¢do de uma imagem, clique em “Ferramentas de Videos” e edite a duracao.

,& =R ] s | Ferramentas de Video | Ferramentas de Musica Meu Filme - Movie Maker
m Inicio Animacdes Efeitos Visuais Projeto Exibir Editar Opcoes

I;&jDuratéo: 7.00 ¥ I Divi

30,00
00:07,03/00:40,50 [

4l | > I



Vocé podera gravar uma narragao ou adicionar arquivos de dudio do seu computador.
Para adicionar musica, clique em “Adicionar uma Musica” e escolha o arquivo disponivel em

seu computador.
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E possivel escolher o ponto inicial e final da musica, como mostra a figura abaixo.

B = 9 < Ferramentas de Video Ferramentas de Miisica Meu Filme - Movie Maker
m Inicio Animacdes Efeitos Visuais Prajeto Exibir Editar Opcées

\-') 4 Fadein: [Nemhum -] | =i 5 Definir hora de inicio  Hora de inicio: 0,005

1o Definir ponto inicial  Ponto inicial: | 0,00
Volume da g . - Dividir
e oAl et | Nenhum - Definir ponto final Ponto final: | 14,30s

Definir ponto final (0)

v

Carte a musica selecionada para que ela
termine no ponto atual.

Para mover de lugar a musica, clique na mesma e arraste até o ponto escolhido. Vocé pode

editar caso a musica tenha uma duracdo maior que as imagens.



Ferramentas de Video  Ferramentas de Musica  Meu Filme - Movie Maker
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O “Fade in” € um recurso que serve para aumentar lentamente o volume da musica no inicio
até chegar no volume original e o “Fade out” € um recurso que serve para ir diminuindo
lentamente o volume da mdsica para suavizar e nio terminar abruptamente. E possivel escolher

a velocidade do Fade entre lento, médio e rapido.
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=2 3+ Definir ponto inicial Ponto inicial: |0,00s

a0

Volume dff g : Ra - Divi
musica ol E3d60ut |Rapido =+ Definir ponto final Ponto final: 14,30s

Fade out

Escolha a velocidade do fade out da musica




Caso queira aplicar efeitos de animacio, clique em “Animacio” e escolha uma das transicoes
9

do menu. Vocé pode escolher a duragdo e aplicar a todos os slides ou escolher animacgoes
diferentes para cada um.

a = E') = Ferramentas de Video  Ferramentas de Musica Meu Filme - Movie Maker

m Inicio Efeitos Visuais Projeto Exibir Editar Opcdes

_o) Duracdo: | 1,50 4

@ Aplicar a todos

iddoacd LAR 4 ma G

4l

Para adicionar o titulo, clique em “Titulo”.

B aoe-s Ferramentas de Video  Meu Filme - Movie Maker
Inicio Animacdes Efeitos Visuais Projeto Exibir Editar

= X Recortar Vidzo aa webear] 5
EE < ]| A Sh Knemow
[ copiar = / Gravar narracio ~ |i=i| Legenda | | - .
Cor Adicionar  Adicionar i - B || BRee| "B | T Giorpes Gierpan i serccionsr tudo
videos e fotos uma misica -~ [&] Instantaneo 48| Créditos ~ | aesquerda adireita

Adicionar titulo

B ~dicione um novo titulo antes do item
f  selecionado.

[FVO0PW W T S




Vocé pode escolher a fonte, o tamanho da letra e a cor da mesma, a cor do plano de fundo e a

duracéo da exibigédo do texto na tela.

Ferramentas de Video ~ Ferramentas de Texto  Meu Filme - Movie Maker

B o9es
Inicio Animacdes Efeitos Visuais Projeto Exibir Editar Formato
2 A £ Cor do plano de fundo ~
D Segoe Ul v148 ~ |} A4 Transparéncia A = L3 & |w =
Copia ) 5 Hora de inicio: 0,005 = «:\9 p— =4
Colar A~ A a1l =) Editar @ o (e o= =
N Z 47 A e texto I 1§ Duracio do texto: 7,00 vI — - |- = = =

00:02,07/00:26,50

S UL 2

Para adicionar legenda, clique em “Legenda” e adicione o texto que serd exibido no video ou

na foto.

B a9eE- Ferramentas de Video ~ Ferramentas de Misica  Meu Filme - Movie Maker

Inicio Animacdes Efeitos Visuais Projeto Exibir Editar Opcées

> k 7< Remover

D X recortar E@ Js @ video da Webcam [ Titulo -
| o A ‘
Copiar Gravar narracio - [E]] Legenda ("
Colar & Adicionar  Adicionar —— F “‘— Girar para Girar para ii3) selecionar tudo &
ita

aesquerda a dire

ek La8 4 oala b oW

A Titulo H A CREDITOS

22| Créditos ~

videos e fotos uma musica = E] Instantaneo

Adicionar legenda

Adicione o texto que serd exibido no video
ou na foto.

13,47/00:40,50

Vocé pode definir a duracdo de exibicdo do texto como mostra a figura abaixo.



EI =] = Ferramentas de Video  Ferramentas de Musica  Ferramentas de Texto Meu Filme - Movie Maker

m Inio  Animacdes  Efeitos Visuais  Projeto  Exibir Editar Opcdes Formato
EI 0 lsegoewt +|72 v A4 Transparéncia % — — =
Co 5 Hora de i 1403 = = a—n (W= k§\$ =4 ==
Colar NI A+ AL Editar] .
textol| L3 Duracio do texto: 5,47 -

ACREDITOS

4 b I

Agora sim, vocé pode salvar o seu filme. Clique em “Arquivo” depois em “Salvar filme”.

- Ferramentas de Video  Ferramentas de Mdsica  Meu Filme - Movie Maker

Arquive pedes
) Configuracio recomendada
Novo projeto e
_| -
B%  Recomendivel para este projeto efinir ponto final

L“ Abrir projeta

Configuracies comuns -
L Recomendével para este projeto

080" -
H Salvar projeto Para monitor de alta definicio Tamanho de exibicio: 1920 x 1080 pixels

Taxa de proporcio: widescreen
Taxa de bits: 24,13 Mbps

H Salyar projeto como L‘ Pars computador Tamanho estimado do arquivo: 172,58 MB por

minuto de video
Qt} Publicar filme 3 —|  Para gmail
[

Configuracbes de telefone e dispositivo

;AI.I. TEEE s od L

EJ Salvar filme > -
|:'—J- Celular Simples (grande]

<\l =
Lg Importar de dispositivo =

|:~'w Celular Simples ([pequeno}
%= | Opcdes

Telefone com Android (grande)

=

) sobre o Movie Maker &
Bl Teietone com Ancroid (médio)
-
*| sair - =

Em seguida aparece essa tela e vocé vai escolher onde quer salvar.

D& um nome para seu video e clique em salvar.



% Salvar Filme

™ B

« 05(C) » Usuarios » Vera » Videos v 0 Pesquisar Videos R

Organizar « Mova pasta

5| Documentos o *
4 Downloads
&= Imagens

dissertacio Meu Filme
J\. Musicas
tutorial movie

B Vvideos

¢& OneDrive
[ Este Computador

=¥ Rede 4
Nome |

Tipo: | Arguive de Video MPEG-4/H.264

# Ocultar pastas Cancelar

Vocé pode salvar o filme ou salvar o projeto. No primeiro caso vocé ndo podera mais fazer
modificagdes e essa sera sua versao final. No segundo caso, vocé podera continuar editando seu

video, fazendo as modificacdes que achar necessario.

B = Ferramentas de Video  Ferramentas de Texto

m Inicio Animacdes Efeitos Visuais Projeto Exibir Editar Formato

LA Taula il LA Clae

1
B2 Movie Maker X

A CREDITOS

Cancelar

Para salvar o projeto, clique em “Salvar projeto”.



Ferramentas de Video

I XA

Ferramentas de Texto  Meu Filme - Movie Maker

Novo projeto

V]
If_\ Abrir projeto
T— |

Salvar projeto (Ctrl+5)
R Salvar projeto ¢o

% Publicar filme »
B | sawvarfime »

M Impartar de dispositivo

v
=

Projetos recentes

Opcdes
o
-

b

| sair
]

Sobre o Movie Maker

rmato

efinir ponto inicial

efinir ponto final E—‘:

CET
I w’ .
= A
PP WP RPUPRY BH
:

D& um nome para o projeto, escolha onde quer salvar e clique em “Salvar”.

: A CREDITOS

Salve o Projeto

= « “ @ » Este Computador » Videos

Organizar * Mova pasta

A
#F Acesso rapido

I Area de Trabz #

@ Documentos

; Downloads

= Imagens b
dissertagdo

J) Musicas
tuterial movie

m Videos

f@ OneDrive o

v 0

Pesquisar Videos

Menhum itern corresponde 3 pesquisa,

L]
1

MNome: | Meu Projetol

Tipo: | Projetos do Movie Maker

= QOcultar pastas

Salvar

Cancelar




TUTORIAL ADOBE PREMIERE




Conhecendo o Adobe Premiere

O Adobe Premiere é um dos softwares de edi¢do de video mais utilizados na atualidade, tanto
por profissionais quanto por pessoas que queiram um programa com mais recursos. Vamos

conhecer as func¢Bes basicas do Adobe Premiere.

Esse programa é pago mas na internet vocé encontra versdes mais antigas para Download

gratuito. O Premiere CS2 ¢ free.
O layout do CS2 é similar as versdes mais atuais.
Essa é a primeira tela que vocé encontra quando abre o Adobe Premiere.

Vocé pode criar um novo projeto, como esta destacado abaixo, abrir um projeto ja existente ou

selecionar um da lista dos projetos recentes.

Welcome to Adobe Premiere Pro >

Adobe” Premiere

Recent Projects

Mew Project Open Project Help

Essa ¢ a tela que aparece quando voce clica em “Novo Projeto”.



Como esté destacado em vermelho abaixo, vocé escolhe um local onde quer salvar o projeto e

da um nome para 0 mesmo.

Clique em OK para continuar.

‘ New Project X

Nessa tela voceé ira criar uma sequéncia, ou seja, aonde voce ira editar o seu video. Como esta
destacado, vocé pode escolher configuragdes pré-programadas para o seu video. Dé um nome

para sua sequéncia e cliqgue em OK.

New Sequence B4




Essa é a tela principal do Adobe Premiere. Na parte inferior direita esta a timeline, na inferior
esquerda fica os arquivos que vocé vai importar, na superior direita fica o Preview, ou seja,

como seu video esta ficando, e na superior esquerda ficam configuractes de efeitos.

B Adobe Premiere Pro - E\Tutorial premiere\ Tutorial prproj *

00:00:00:00 L v o hd 00:00:00:00
i}

00:00:00:00

Para importar fotos, videos ou musicas, cligue com o botdo direito na area destacada em

vermelho e clique em importar.

B ~dobe Premiere Pro - EATutorial premiere\Tutorial.prproj *
e Edit Project Clip Sequence Marker Title Window Help

00:00:00:00 i v ul v 00:00:00:00

00:00  00:00:14:23 0:00:44:22  00:00:58 00:01:14:22 :29:21  00:01:4421  00:0L:3!

St

I

PN,




Abaixo observamos o exemplo, vérias fotos foram importadas.

B Adobe Premiere Pro - ExTutorial premieret Tutorial.prproj * - X
File Edit Project Clip Sequence Marker Title Window Help

00:00:00:00 [Fit v 00:00:00:00
(1]

Animag;

00:00:00:00 00:01:14:22 0

Vocé pode clicar em um dos dois icones destacados para mudar a visualizacdo dos arquivos

importados, criando uma lista como vemos no exemplo.

Adobe Premiere Pro - E\Tuterial premiere\ Tutorial prproj * - X
File Edit Project Clip Sequence Marker Title Window Help

00:00:00:00



Selecione as fotos ou videos e arraste para o inicio da timeline. Se vocé arrastar um video que
tenha configuragdes diferentes das configuragcdes da sequéncia que vocé escolheu antes ira
aparecer uma mensagem perguntando se vocé deseja trocar as configuracfes da sequéncia para

ficarem iguais as do video. Aceite para que ndo tenha nenhum conflito.

400:00:00:00 'Fit hd ul - 00:01:14:23

st

T

InEENENNEN
PN, D

Se preferir ver a timeline com mais clareza, selecione a ferramenta destacada abaixo e clique
na timeline para dar zoom in. Se quiser dar um zoom out segure o alt do teclado e clique na

timeline.

00:00:00:00 i - Ful v 00:01:15:00




A principal ferramenta utilizada é a de sele¢éo. Veja abaixo:

Il Adobe Premiere Pro - ExTutorial premiere\Tutorial,prproj *

File Edit Project Clip Sequence Marker Title

Frame Rate

m o m A

Window  Help

00:00:00:00

1]

Program: An

Animagdo

00-00-00:00

Selection Tool (V)
g -

00:01:15:00

Caso vocé queira trabalhar com a timeline em frames ao inves de tempo, siga 0s passos abaixo.

Clique em “Sequéncia” e depois em “Configuragdes de Sequéncia”.

File Edit Project Clip)

| Adobe Premiere Pro - E:\Tutorial premiere\ Tutorial prproj *

Sequence | Marker Title Window _Help

Sequence Settings...

Render Effectsin Work Area

Render Entire Work Area

Render Audio

Delete Render Files

Delete Work Area Render Files

Match Frame

Add Edit

Add Edit to All Tracks

Tiim Edit

Extend Selected Editto Playhead
fideo Transition
udio Transition

Apply Default Transitions to Selection

Lift

Extract

ZoomIn

Zoom Out

Go to Gap

Snap

Closed Captioning
Normalize Master Track.

Add Tracks..
Delete Tracks..

E

CtrlsK
CtrlShifteK
T

E

Ctrl+D
CtrlShift-D

Rl vl R 1800

Nesse caso, aparecerd essa tela. Clique em formato de display e escolha ‘Frames” e clique em

OK para confirmar.



Se quiser mudar a duracdo em frames de uma ou mais fotos, selecione uma ou mais imagens e

clique com o botdo direito e selecione “Velocidade/Duracdo”.

[El Adobe Premiere Pro - EATutorial premiere\Tutorial prproj *

A

Edit Project Clip Sequs M

¢ Title Window Help

boneco.jpg

Ripple Delete
Replace With Clip
Enable
Group

Ungroup
Synchranize

Speed/Duration...
R =

Frame Blend
Scale to Frame Size
Adjustment Layer
Rename.

Reveal in Project

Vai aparecer essa tela abaixo que dara opcdo para vocé escolher a duracdo em frames, nesse

caso colocamos 4. Selecione a caixa destacada em vermelho para automaticamente rearranjar

as imagens na timeline para que ndo haja espagos vazios ou sobreposicoes.



- E\Tutorial

File Edit Project Clip Sequence Marker Title Window Help

Clip Speed / Duration

Na tela abaixo esta mostrando uma mausica e trés efeitos sonoros que importamos.

B Adobe Premiere Pro - EXTutorial premiere\Tutorial. prproj ~

e Edit Project Sequence  Marker Ttle Window  Help

Para ficar com uma leitura mais facil vocé pode renomear as faixas de audio da timeline
clicando com o botdo direito no nome da faixa de audio (o padrdo é audio 1, audio 2, etc),

renomear e escrever o nome de sua preferéncia. Clique na timeline para confirmar.



I Adobe Premiere Pro - EXTutorial premiere\ Tutorial prproj *
File Edit Project Clip Sequence Marker Title Window Help

Animacio

0

Add Tracks.
Delete Tracks...

Delete Track

POR 2244
BOB i wvars

Nesse caso renomeamos a primeira faixa para “Musica” e a segunda para “Efeitos Sonoros”.
Vocé pode também adicionar novas faixas clicando com o botdo direito acima das faixas

existentes e escolhendo “Adicionar Faixas™, como destacado.

I Adobe Premiere Pro - E\Tutorial premiere\Tutorial.prproj
File Edit Project Clip Sequence Marker Title Window Help

Program: Animagao | v

4

e
23

&5

Add Tracks..

Delete Tracks...

£

PEN



Seguindo os passos acima, aparecera essa tela. Escolha quantas faixas de video e dudio quiser
adicionar. Nesse caso, trocamos a quantidade de faixas de videos para 0 e deixamos uma de
audio. Clique em OK para confirmar.

Add Tracks X

Agora, como destacado abaixo, temos trés faixas de audio. Uma para musica e duas para efeitos

SOnoros.

Adobe Premiere Pro - EATutorial premiere\ Tutorial.prproj * - X




O proximo passo € arrastar a musica da lista dos arquivos importados para o inicio da faixa

musica na timeline, como destacado abaixo.

Para adicionar os efeitos sonoros no frame correto, podemos utilizar o slider amarelo destacado
em vermelho a esquerda da seta branca. Destacado no quadrado vermelho da esquerda, vocé
pode ver em qual frame vocé esta, nesse caso estamos no frame 4. Vocé pode escolher o frame
clicando no slider amarelo e usando as teclas esquerda e direita do teclado para voltar ou

avancar um frame. Isso permite editar com mais preciséo.




Com o frame no qual vocé quer adicionar o efeito sonoro escolhido, certifique-se que o bot&o

de um imé, destacado no quadrado do meio acima, esta selecionado.

Agora arraste o efeito sonoro escolhido para a faixa de efeito sonoro da timeline e em cima da
linha vertical vermelha, que indica em que frame vocé estd, e solte para adicionar o efeito

Sonoro.

No exemplo abaixo adicionamos o0s outros efeitos sonoros em diferentes faixas e diferentes

frames.




Se quiser diminuir o tempo da musica para coincidir com o tempo das imagens, use a ferramenta

de selecdo, clique na borda direita da faixa de musica e arraste 0 quanto precisar para a esquerda.

iobe Premiere Pro - EATutorial premiere\ Tutorial.prproj — o
Adobe P Pro- EATutorial \Tutorial, - X
Edit Project Sequ rker Title Window Help

Vocé também pode diminuir a musica para que ela figue menor do que o tempo das imagens,

caso queira, por exemplo, adicionar mais de uma mausica.




Podemos também diminuir ou aumentar o tempo de exibicdo de cada imagem como destacado

abaixo, usando 0 mesmo processo anterior que aplicamos a musica.

[ Adobe Premiere Pro - E:\Tutorial premiere\ Tutorial prproj * - x
File Edit Project Clip Sequence Marker Title Window Help

Project: Tutorial

Misica

e

Para salvar o projeto clique em “Arquivo”, “Salvar”, pois o local ja foi escolhido quando criou

0 projeto.

B :dobe Premiere Pro - E\Tutorial premiere\ Tutorial.prproj * - X
Edit Project Clip Sequence Marker Tile Window Help
New >

Open Project.. Cti+0
Open Recent Project >
Browse in Adobe Bridge. Ctrl+Alt+0
Close Project Ctrl+Shift=W
Close Ctrl+W
Save Ciries

Save As... Cirl+Shift+S
Save a Copy.n Cirl+Alt+S.
Revert

Capture.. F5
Batch Capture... F6

Adobe Dynamic Link
Adobe Story >

Send to Adobe SpeedGrade...

Import from Media Browser CtrlsAlt+]
Import... Ctri+|
Impart Recent File >
Export >
Get Properties for >

Reveal in Adobe Bridge...




Para exportar o video finalizado, clique em “Arquivo”, “Exportar”, “Midia” ou use as teclas de
atalho CTRL + M.

R Acdobe Premiere Pro - EATutori
JFie Jeait project Clip Sequ

crl+0

Ciri-Alt+0

Ctrl+ Shift- W
Close Cirl+ W
Save Cirl+S
Save As... Ctrl+Shift+S
Savea Copy.. Ctrl+Alt+S

Capture. 5
Batch Capture.. F6

Adabe Dynamic Link
Adobe Story >

Send to Adobe SpeedGrade...

Import from Media Browser Ctrl+Alt+|

Import. Ctrlsl

Import Recent File >
L 2

Get Properties for >
Reveal in Adobe Bridge.

Exit

Aparecera essa tela abaixo. Selecione o quadrado destacado em vermelho para exportar com as
mesmas configurac6es da sequéncia com a qual estdvamos trabalhando antes. No sumario, vocé
pode ver escritas as configuracGes do output e de origem (source). Se estiver a mesma nao
havera nenhum problema. Clique em “Exportar” como destacado na parte inferior da tela para

exportar seu video. Ao término desse processo seu video estara pronto para ser publi

Export Settings X

t

¥ Export Settings
Scale To Fit

Metadata...
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